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ARTICLE INFO ABSTRACT

Keywords: Currently, in the state of Colorado and all other states within the United States of America with legalized
Colony forming units of yeast and molds marijuana programs, testing is required for bacteria, yeast, and mold on marijuana products. The Code of
ImageJ Colorado Regulations, 1 CCR 212-1, considers a passing result when a 1 g sample contains < 10* colony forming

Candida albicans
Automation of CFU counting
Manual CFU counting
Petrifilms

units (CFU) for the total yeast and mold count (TYMC). These measurements are usually obtained by manually
counting colonies on petri-dishes or 3 M™ Petrifilms™, which is a time consuming and user subjective process.
Therefore, an automated counting method utilizing ImageJ has been developed for CFU analysis of TYMC on
Petrifilms. The performance of this colony counting method was demonstrated by comparing manual and au-
tomated counts from marijuana flower samples containing spikes of Candida albicans as well as samples that
tested positive for the presence of yeast and mold. Fifteen images of Petrifilms showing various concentrations of
colonies were studied by fifteen users at two institutions using both the automated and manual counting
methods. All counts from the automated ImageJ procedure were within 12% of those obtained manually. In
twelve out of fifteen Petrifilms, the average count of the automated method was statistically similar to the
manual counts. The statistical differences of the other three samples were observed to be random and caused by
user errors. The automated counting method could be used to quickly count numbers that are as high as 400
CFUs, reducing time of analysis with improved documentation because the images and the electronic colony

counts can be saved on a computer or cloud for long term storage and data access.

1. Introduction

Quality control testing in the food and marijuana industries is a
requirement that involves cell enumeration of bacteria and fungi to
comply with state and federal regulations. In US states where marijuana
has been legalized, these regulations include the determination of total
yeast and mold count (TYMC) in all consumer facing products to pre-
vent health problems (Cescon et al., 2008; Verweij et al., 2000).

There are several methods used for cell enumeration in micro-
biological testing labs, including plate counting (Wilson et al., 2017),
polymerase chain reaction (PCR) (Knight et al., 2018), and using a
hemocytometer (Salm et al., 2010). Plate counting measures viable cells
as colony forming units (CFUs) in dilute liquid culture samples by
spreading the sample on agar plates so that a single cell results in a
colony that can be counted by the naked eye. This process requires little
instrumentation and few user skills (Wilson et al., 2017). PCR is a quick,
automated method but requires expertise to perform and interpret,
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along with costly equipment and supplies, such as a thermal cycler and
PCR reagents (Knight et al., 2018). With a hemocytometer, cells can be
counted manually in a homogenous liquid sample. But this method
requires a microscope, more user training, and does not distinguish
between live and dead cells (Salm et al., 2010). Many laboratories still
rely on manual plate counting, even though this technique is tedious,
time-consuming, and subjective. Automation has the potential to sim-
plify this process, reducing variability between analysts and increasing
lab productivity (Cadena-Herrera et al., 2015). While several efficient
software suites have been developed to automatically count cells, some
of them are restricted to only certain type of cells and cannot be applied
to coalescing yeast and mold colonies when concentrations are high.
CellProfiler, for example, is a free of cost application that is able to
count both mammalian and non-mammalian cells and has the ability
for high throughput analysis. However, non-mammalian cells are lim-
ited to only round yeast cells. CellC is also a free of cost, modifiable
software that is able to only count fluorescently labeled or tagged cells.

Received 12 July 2019; Received in revised form 26 July 2019; Accepted 27 July 2019

Available online 02 August 2019
0167-7012/ © 2019 Elsevier B.V. All rights reserved.



N. Stolze, et al.

The software is capable of distinguishing cell clusters of various species
into single cells by a double staining process, hybridizing bacteria with
species-specific probes and staining with 4’,6-diamino-2-phenylindole
(DAPI) for the non-hybridized bacteria (Selinummi et al., 2005). Other
cell counting software applications include CellCounter (Ho, 2019) and
OpenCFU (Geissmann, 2013), which are designed for specific cell types
and may require staining.

ImageJ has been utilized for counting colonies as an open-source
image analysis program for Macintosh, Windows, and Linux operating
systems (Wilson et al., 2017). Additionally, plugins and macros can be
downloaded or created and applied to ImageJ for quicker and easier
analysis. For example, Image-based Tool for Counting Nuclei (ITCN) is a
plugin that works well for counting nuclei (Kuo and Byun, 2019), but
has not been utilized for counting yeast and molds, probably due to
their morphological diversity at higher concentrations. Automatic
mammalian cell counting with ImageJ was previously reported but
required the use of two consecutive macros using images that were
obtained by a hemocytometer (Grishagin, 2015).

The automated ImageJ counting method of yeasts and molds re-
ported here allows for the counting and discrimination of overlapping
colonies of various morphologies even at concentrations considered too
numerous to count (TNTC) by the US Food and Drug Administration
(FDA) (Maturin and Peeler, 2001). Furthermore, the method only re-
quires a simple photograph taken by a smartphone without requiring
fluorescent staining, a microscope, or a hemocytometer. 3 M™ Petri-
film™ Rapid Yeast and Mold Count Plates were used in this method
because they contain a color indicator to visualize yeast and mold
growth (Beuchat et al., 1990; Vlaemynck, 1994).

3M™ Petrifilm™ Rapid Yeast and Mold Count Plates are sample-
ready-culture medium systems that contain nutrients, antibiotics, and a
water-soluble gelling agent. Yeast and mold colonies on these plates can
be distinguished by color, where yeasts appear as blue-green colonies
with defined edges and no foci while molds are variably-colored co-
lonies with foci and distorted edges (Bird et al., 2015; Chandrapati and
Nordby, 2014). The color change on the Petrifilm is due to the enzy-
matic activity of phosphatases (Chandrapati and Nordby, 2014). A
3 M™ Petrifilm™ Plate Reader is commercially available for automated
quantification of aerobic coliform and E. coli/coliform colonies. How-
ever, this reader is not yet compatible with the yeasts and molds Pet-
rifilm due to the variability in colony morphologies. Thus, this auto-
mated counting method utilizing ImageJ for the analysis of yeast and
mold CFUs on Petrifilms is advantageous especially for high CFU con-
centrations and was observed to be as effective as the manual method
but outperformed the manual method at high concentrations.

2. Methods

2.1. Preparation of control and marijuana flower matrix spike of Candida
albicans 3 M™ Petrifilms™

All sampling and Petrifilm preparation were performed at
AgriScience Labs (Denver, CO). As a positive control and to assure the
Petrifilms were working properly, only one yeast species, Candida al-
bicans (C. albicans) (ATCC 10231) cells using KWIK-STIK™, were
streaked on standard agar plates and incubated at 25°C = 2°C for
24-48 h. After the incubation period, one isolated colony was trans-
ferred to 9.0 mL of buffered peptone water (BPW1, 1 g/L). Ten-fold
serial dilutions (10! to 10~7) were prepared with fresh BPW1 as the
diluent. Each dilution was incubated for 24 h at 25°C = 2 °C, plated on
Petrifilms (3 M™ Petrifilms™ Rapid Yeast and Mold Count Plate) and
incubated at 25°C + 2°C for 60-72 h. Following incubation, colonies
were counted to determine the optimal concentration that allows the
count to be quantifiable. For the marijuana flower spiked sample,
0.5mL of the C. albicans culture that showed the best quantifiable
concentration was added to a sterile, two-sided Whirl-Pak® bag with a
finely perforated, polyethylene filter for separation (Nasco). A 1.0g
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sample of autoclaved marijuana flower was added and diluted with
8.5 mL of BPW20 (20 g/L). For the C. albicans control sample (without
marijuana flowers), 0.5mL of the C. albicans culture was added to a
sterile Whirl-Pak® containing 9.5 mL of BPW20. Three consecutive ten-
fold dilutions (1:100, 1:1000, and 1:10000) of the control and flower
spiked samples were made with BPW1 and plated on 3 M™ Petrifilms™.

2.2. Preparation of marijuana flower samples on 3 M™ Petrifilms™

A minimum of 2.0g of marijuana flower sample was aseptically
weighed and placed into one side of a sterile Whirl-Pak® bag. Samples
were diluted ten-fold in the bag with BPW20 tempered to 36-38 °C by
adding a volume of nine times the mass of the sample. The bags were
then masticated by hand for 30 to 60 s to homogenize the sample. From
the opposite side of the filter to which the flower sample was added,
1 mL of the resulting liquid was diluted into three consecutive ten-fold
dilutions with BPW1 (1:100, 1:1000, and 1:10000). One mL of each
dilution was plated onto separate 3 M™ Petrifilms™ and incubated for
60-72h at 25 + 2°C.

2.3. ImageJ automated cell analysis

Images were taken with an iPhone 7, containing a 12 M-pixel (f/1.8)
camera. Fifteen Petrifilm images of the samples were analyzed with
ImageJ by fifteen users at Doane University (Crete, NE) and AgriScience
Labs. For automated cell analysis, the image of the Petrifilm was
opened in ImageJ. The area of the smallest visible colony on the film
was measured in pixels squared by first using the oval region of interest
(ROI) tool to outline the colony. The “Measure” tool under the
“Analyze” tab opened a “Results” box with the determined area of the
drawn circle. Then, a circle was drawn around the edge of the Petrifilm
with the oval ROI tool (Fig. 1A). Under the “Edit” tab, “Clear Outside”
was used to remove the area outside of the oval from the analysis area
(Fig. 1B). Under “Image” and “Type”, the image was converted to 8-bit
(Fig. 1C). The threshold, located in the “Image” tab under “Adjust”, was
set by the user to make sure colonies were highlighted as black spots
with a background white (Fig. 1D). It was important not to hit “Apply”
after setting the threshold, but to just close out of the window. Under
“Process” and “Binary”, the image was converted to a mask (“Convert
to Mask”) before using the “Watershed” tool to split merging colonies
with a 1-pixel wide line as shown in Fig. 1E. Lastly, a circle was drawn
again around the edge of the Petrifilm eliminating any partial CFUs on
the edge that were not to be included in the final CFU count. Under
“Analyze”, “Analyze Particles” was selected. The area of the smallest
colony previously acquired was used to set the parameter for the par-
ticle size range, beginning with a value lower than the area determined
prior. For example, if the area was observed to be 577 pixels squared,
the range was set as “377-Infinity”. The circularity parameter was set as
“0.20-1.00” and an overlay was used to highlight and number the co-
lonies counted. Making sure to select “display results”, “Clear results”,
“Summarize”, and “Exclude on edges”, the results displayed the number
of particles that fit the parameters within the image and was used as the
total CFU count (Fig. 1F). In addition to the written standard operating
procedure (SOP) generated, computer screen overlay videos were cre-
ated to assist new users with the automated and manual counting
methods (Table S1) .

2.4. ImageJ manual cell analysis

A “Cell Counter” plugin was downloaded for ImageJ from the
National Institutes of Health (De Vos, 2019). The image of the Petrifilm
was opened in ImageJ. Within the “Plugins” tab, the “Cell Counter” tool
was opened. Manual cell counting was carried out by using the multi-
point tool in which each countable colony was marked by clicking over
it and a running count of the total colonies was recorded. In both
methods, the total CFUs was determined by visible colonies including
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Fig. 1. ImageJ automated cell analysis of a Petrifilm image. A) Petrifilm colony forming area outlined with the oval ROI tool. B) Outside of the ROI cleared. C) Image
converted to 8-bit. D) Threshold set to highlight colonies as black particles. E) Merging colonies split by a single pixel line via the “Watershed” tool. F) Particles
included in the total count, highlighted and numbered in an overlay on the image.
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Fig. 2. Two images that were used to instruct users how to test the automated and manual colony counting method. Users were instructed not to include fine plant
particles (left image) or colonies on the edge of the Petrifilm (right image) in the count. However, faint colonies (right image) were counted.

faint colonies but excluded colonies on the outer edge of the Petrifilm
and visible plant particles (Fig. 2).

3. Results and discussion
3.1. Petrifilm image analysis

Table 1 highlights the major advantages and disadvantages of the
manual and automated cell counting methods. Both methods have the

potential for variability from user to user or within one user, which are
the major causes of error in the reported results. Users may insert a bias

within both methods when selecting what constitutes a colony. Even
though specific instructions were provided, some users may include
faint colonies or count certain colonies on/close to the edges, while
others do not. In some samples such as the AgriScience client marijuana
flowers, small blue particles are visible and considered debris and
should not be included in the total CFUs but may be misinterpreted as
colonies. To address this issue, the automated method was designed to
limit the number of particles in the results by restricting the analysis
particle size to a specific diameter and only include particles in the
count that were defined by their circular dimensions. The manual
method also had greater potential for issues when colonies were
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Table 1
Advantages and disadvantages of manual and automated CFU counting methods.
Manual Automated
Advantages Disadvantages Advantages Disadvantages

® Inexpense ® Subjective to what counts as a colony and how

® Low tech many colonies are merged in a single spot

® Little training ® Not consistent between counts and users
required ® No electronic record

® Quick

® Inexpensive

® More objective

® Optimization available

® Watershed feature available

® Quick but could be quicker than manual in

® Some training

® Computer and software required

® Subjective due to thresholding and
estimating particle size

high count samples

® Electronic record for data storage/review

crowded and users may easily lose track of which colonies have already
been counted, even when the embedded grid in the Petrifilm was used.
In the automated method, the “Watershed” tool was used to estimate
the individual colonies within a crowded section so that every single
colony was included within the count even when colonies overlap. The
automated method also included factors that could potentially influ-
ence variability including the ROI drawn, the threshold set, and the
estimate of the smallest colony particle size, which are all set and
controlled by the user.

Fifteen Petrifilm images (Fig. 3) were obtained and analyzed by
fifteen different individuals using ImageJ to determine CFU count,
performing both the manual and automated methods described (Table
S2). The results of the CFU counts from both methods were compared to
determine if the automated method is an efficient alternative to the
manual counting method. The fifteen images that were selected were
actual client samples providing a realistic scenario of controls and
flower samples in a daily analytical lab operation. Furthermore, the
images show that the samples contain various colony morphologies and
coverage, which is also a typical lab situation in official marijuana
testing facilities. The spiked flower sample, the C. albicans control, and
Flower Sample 1 (Fig. 3) were all officially reported to be TNTC when
manually counted by AgriScience, with the number of colonies ex-
ceeding 250 per plate (Table S2). However, when ImageJ was used in
the manual method to track the colonies and when those counts were

1:100
Dilution

Sample 1:1000
P Dilution
Flower Spike
Candida
Albicans

Control
Candida
Albicans

Flower
Sample 1

Flower
Sample 2

Flower
Sample 3

1:10000
Dilution

compared with the ImageJ automated analysis, it became evident that
the automated method was able to efficiently analyze all three samples
with similar counts.

3.2. Statistical comparison of manual vs automated counting methods

The manual and automated CFU counts were analyzed with a series
of statistical analyses. Average and standard deviation for both methods
were calculated after each data set was tested for an outlier by Q and T,
tests at a 95% confidence level (Fig. 4; Table S2 and S3) (Mandel, 1978;
Raschka, 2014). The percent difference was determined by comparing
the automated method average to the average of the manual method to
determine how closely the two methods functioned (Table S3). The
highest percent difference was 12.3% for flower sample 1 (dilution
1:100), which had the most clustered colony growth, making it a
challenge to count accurately with either method. All other images had
percent differences of < 10%. Calculated p values were used to de-
termine if the averages from the two methods were statistically the
same. Three of the fifteen images (flower 1 dilution 1:100 and 1:10000
and flower sample 3 dilution 1:1000) had p values < 0.05 (0.002, 0.01,
0.04, respectively), indicating that the counts were statistically dif-
ferent between the manual and automated method, which was con-
firmed by the F value. The F values (13.81, 8.82, 5.13, respectively)
were greater than the F crit values (4.60, 4.67, 4.60), which also

Fig. 3. Five different samples were plated on 3M™
Petrifilms™ at various dilutions for analysis of yeast and mold
CFU counts using both manual and automated methods. The
matrix spike contains a mixture of multiple flower strains and
was spiked with C. albicans. The control was prepared with
only the C. albicans culture. Flower samples 1, 2, and 3 are all
different marijuana flowers. Images of samples at dilution
factors of 1:100, 1:1000, and 1:10000 were chosen for ana-
lysis.
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Fig. 4. Average CFU count from the image analysis of 5 samples (FS — Flower
Spike C. albicans, C - Control C. albicans, F1 - Flower sample 1, F2 - Flower
sample 2, and F3 - Flower sample 3) at three dilutions [1:100 (x2), 1:1000 (x3),
and 1:10000 (x4)] using manual (solid blue bar) and automated (dotted orange
bar) analysis. Three samples are considered to have CFU counts from the
manual and automated method statically different and are marked with the
calculated p-values. Error bars represent the standard deviation of user counts
excluding any outliers determined. n = 15, *average and standard deviation of
one method exclude an outlier where n = 14, **averages and standard devia-
tions of both methods exclude an outlier where n = 14. Numerical values
presented in Table S3. (For interpretation of the references to color in this figure
legend, the reader is referred to the web version of this article.)

confirmed the statistical difference in CFU counts for these three
images. This statistical difference cannot be explained by either dilution
factors or sample identity. If dilution was a factor to the performance of
both methods, then the same dilution for every sample would have led
to a similar statistical difference. If the sample identity was the reason
for the statistical difference, then all dilutions of the same sample would
have shown this difference between the counting methods as well.
However, as seen in flower sample 1, the high and low dilutions (1:100
and 1:10000) were different but the middle dilution was not (1:1000).
This clearly demonstrates there is no obvious explanation for the sta-
tistical difference and therefore, could be caused by user bias.

Table S4 also shows that the variations between the two methods
are not associated with dilution factors or difficulties in counting co-
lonies due to overcrowded growth. The average and standard deviation
of the percent difference for each sample at the same dilution were
fairly consistent throughout the three dilutions analyzed, with the
1:100 dilution showing the greatest percent (4.6 = 4.7%). This con-
sistency suggests that the manual and automated method performed
similarly. The average standard deviation showed that the variability of
both methods decreased as samples were more dilute, which was an
expected outcome as the colonies become more spread out and easier to
count. However, the manual method had a lower average standard
deviation for each dilution as compared to the automated method,
demonstrating that user variability was a greater factor in the auto-
mated method. Finally, the average p-values for all three dilutions
comparing the two methods were 0.41, 0.34, and 0.32, respectively
with a standard deviation leading to the conclusion that both methods
are similar in determining CFUs. Overall, the manual counting method
was easy and sufficient when the CFU count was low, but the auto-
mated count was a quicker alternative when the CFU count was large
and colonies were crowded.

4. Conclusion

The automated counting method for yeast and mold colonies from
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marijuana flowers using ImagelJ allows for counting of colonies even at
concentrations considered too numerous to count by the FDA. Based on
manual and automated cell counts of fifteen users, three of the fifteen
sample images were observed to have a significant difference between
the automated and manual counts, but this difference is believed to be
due to user error and not a method error. Overall, the automated
method was easily learned by the users when they were provided with a
written procedure and a quick instructional video. This method could
serve as an additional or alternative counting tool in state regulated
cannabis testing labs where clients and consumers depend on accurate
results before cannabinoid containing products are sold or consumed.
The electronic record of the images and CFU counts provides the clients
and lab facilities long term documentation, easy electronic storage, and
data review. This is particularly important when a sample fails at > 10*
CFUs per gram at which point the entire batch of marijuana biomass
from where the sample originated would have to be destroyed.
Therefore, the electronic evidence of the failed sample is important for
the business, the testing lab, and the consumer.
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